
GSoC Panel 2016

The LibreOffice GSoC season 2016 has concluded
Here’s the results!
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Where do want to go…

The 2016 project roster

Wastack - Finish Firebird driver integration

(AlexP11223 - Implement Zoner Draw import filter)

Azorpid - Implementing legacy SAX parser Interface with FastParser

ubap - Improve user experience with Table Styles

eszka - Infrastructure for defining toolbars via .ui (Glade) files

Akshay Deep - Redesigning the Template Manager and Emoji Toolbar Control

Jaskaran Veer Singh - Support ODF styles in Calc using Orcus

susobhang70 - Review of Sidebar and it's functionality

autoit - Unifying low-level text layout using HarfBuzz



Finish Firebird Integration

Mentor: Lionel Elie Mamane

Tamás Bunth
IRC: Wastack
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So what do we have?

Upgrade embedded  Firebird to version 3.0

Save Firebird backup format

Fix Firebird related bugs
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TODO

Switch to c++ API

Remote database

Older versions?
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Thanks!
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LibreOffice Brno 2016 Conference Presentation

GSoC – Writer Table Styles

My name: Jakub Trzebiatowski (ubap)
My mentors:

Jan Holešovský
Yousuf Philips
Miklos Vajna
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Google Summer of Code – Writer Table Styles
The projects targets were to implement the 
following:

ODF Export and Import of Table Styles
Table Styles in the sidebar
Table Styles dropdown menu
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ODF Export and Import of Table Styles
The UNO API had to be implemented
Table Styles are exported as a <table:table-
template> element
The following elements are exported as in ODF 
specs

background, body, even-columns, even-rows, 
first-column, first-row, last-column, last-row, odd-
columns, odd-rows

Six extra properties exported in “loext” namespace
first-row-even-column, last-row-even-column, 
first-row-end-column, first-row-start-column, last-
row-end-column, last-row-start-column
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ODF Export and Import of Table Styles
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Table Styles in the Styles and Formatting sidebar
The sidebar is implemented but not yet fully 
finished
Allows to:

Browse the styles and filter applied styles
Apply a style
Update a style
Hide a Style

Currently applied style is highlighted
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Table Styles in the Styles and Formatting sidebar
The dialog to edit properties of a 
Table Style is missing

Table Styles dropdown menu
The dropdown menu is still not 
implemented
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Infrastructure for defining toolbars via .ui 
(Glade) files

Szymon Kłos (eszka)

Mentors:

Jan Holešovský

Samuel Mehrbrodt
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Introduction

Currently available: classic toolbars and sidebar

New implementation mocups
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Goals

Rich and dynamic layout of toolbars

UI easy to modify using graphical tool – Glade (no coding 
needed)

Switching between classic and new mode

Content depending on the context

Layout according to screen/window size
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Results

Tabbed

Contextual groups (Heiko’s concept)

Contextual single toolbar
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First steps

Notebookbar as a child window – below toolbars...

Loading different .ui files in each module

Sfx2 slot mechanism .uno:Notebookar
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Popup conversions

Some popups were able to work 
only in the sidebar

It was needed to create 
controllers for them and register 
in the modules

After conversion they can be 
used in toolbars, Notebookbar 
and other places

Examples: underline, character 
spacing, number format popups



7

Horizontal panels for Impress

Important Impress features are animations and slide 
transitions and should be accessible from Notebookbar

Reused sidebar panels as single horizontal widgets
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Context handling

New toolbar implementation should provide context 
dependent content

Marks in the .ui files e.g.: context-Table, context-any

Tabbed implementation shows additional tabs when user 
pointed table or picture

Heiko’s concept contains static part and group which is 
replaced in some contexts

STATIC PART
CONTEXT

DEPENDENT
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Priorities for widgets

Mechanism providing access to all buttons when window is to 
small to show whole content

Widgets can have assigned priorities

Groups are collapsed, small arrow is showed instead

Content in the popup
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Icon size customization

I added possibility to change icon size in the Notebookbar and 
also Sidebar

That feature is available in the Options

From menubar: Tools > Options > View
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Multiple implementations

We had a lot of concepts

Changing the implementation requires just a reload of another 
.ui file

Added switch in the menubar

New implementations can be added in the 
officecfg/registry/data/org/openoffice/Office/UI/Notebookbar.xcu

<node oor:name="Tabbed" oor:op="replace">
  <prop oor:name="Label">
    <value xml:lang="en-US">Tabbed</value>
  </prop>
  <prop oor:name="File">
    <value>notebookbar_tabbed.ui</value>
  </prop>
  <prop oor:name="HasMenubar">
    <value>true</value>
  </prop>
</node>



12

Toolbar modes

Option to switch between Notebookbar and classic toolbars 
was needed

We had the single toolbar but haven’t any option for easy 
activation

Added entry in the menubar to choose the toolbar mode

Entries in the officecfg (.xcu)

Separate modes for each

module
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What’s next?



14

Customization

Description in the 
XML files

Transformation to 
.ui files ?

Possibility to modify 
by user

<bar:tab id=”tHome” text="Home">
  <bar:group id=”gClipboard” text=”Clipboard”>
    <bar:item href=".uno:Paste" size=”big”/>
    <bar:grid>
      <bar:row>
        <bar:item href=".uno:Cut" size=”tiny”/>
      </bar:row>
      <bar:row>
        <bar:item href=".uno:Copy" size=”tiny”/>
      </bar:row>
    </bar:grid>
  </bar:group>
  <bar:separator/>
</bar:tab>
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Extensions support

Extension developers should be able to add own content to 
the existing implementations

and/or create own implementation
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Shortcuts

Important feature for keyboard users

Showing the key map ?

N

O S E

P
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All text and image content in this document is licensed under the Creative Commons Attribution-Share Alike 3.0 License 
(unless otherwise specified). "LibreOffice" and "The Document Foundation" are registered trademarks. Their respective logos 
and icons are subject to international copyright laws. The use of these therefore is subject to the  trademark policy.

Thank you …
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Redesigning the Template Manager

Akshay Deep

Mentors: 
Samuel Mehrbrodt
Yousuf Philips
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New UX

DESIGN IDEA

FINAL IMPLEMENTATION
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Modifications:

All Templates view replacing the previous Folder view
Search, Application and Category filters replacing Tab 
design
Removal of Save as Template mode
Inbuilt category selection dialog
Most functionalities shifted to context-menu
Marking of default templates for each application
Removal of remote files view
Save as Template dialog
Option to edit a template not in repository
Several other bug fixes
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Modifications:

New ‘Selected + Hover’ state in thumbnail view
How to try it? Just select a template. Now hover over a selected 
template and an unselected template to see the difference

Save as Template
Bug 95402 Improve Save as Template 
work flow

Separated this functionality from 
template manager

Modal dialog with category selection 
and template naming options

Bug 94131 Option to set as default
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Start Center

All Templates view in Start Center with application filter
Context menu for templates in start center
Toggle buttons to denote selected template view
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Impress Selection

Tools > Options > LibreOffice Impress > General > Start 
with Template Selection

Enable users to select a 
template when Impress starts
Easy means to disable the 
dialog on Impress startup
Dialog is Enabled by default Impress Template dialog
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Emoji Toolbar Control �

Akshay Deep

Mentors: 
Samuel Mehrbrodt
Yousuf Philips
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Enhancement

New control, developed from scratch using emojione  
unicode database
Control available in Writer, Impress and Calc, accessible 
via Standard Bar
Free to use any sort of widgets to facilitate the purpose
Use of tabs to filter emojis based on categories
Emojis appear as a grid
Easy insertion, unlike special character control which uses 
a modal dialog as of version 5.2
Font support (Removal of tofu char)
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Font dependent control i.e. not all fonts support them
Unlike svg or png emoji, these emoji are glyphs of a particular 
unicode sequence

How it looks now
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Further Enhancements

The foundation for this enhancement has been built now. 
Further improvements have been proposed like:

Filtering of unsupported glyphs

Removal of duplicate glyphs (multicolor emoji are treated as duplicate 
glyph) as multicolor glyphs are not supported by any font

support for svg emoji, etc.

For further insights, refer to:
https://akkidevblog.wordpress.com/2016/07/23/redesigning-the-template-mana
ger/
https://akkidevblog.wordpress.com/2016/08/19/emoji-toolbar-control/

https://akkidevblog.wordpress.com/2016/07/23/redesigning-the-template-manager/
https://akkidevblog.wordpress.com/2016/07/23/redesigning-the-template-manager/
https://akkidevblog.wordpress.com/2016/08/19/emoji-toolbar-control/
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Miscellaneous Tasks

Goto Page Dialog for LibreOffice 5.3
Online Templates View [abandoned due to lack of server 
framework]
Creation of Active Menu Button
Bug 75369 Non-installed applications aren’t greyed out
Bug 87697 Indicate selected thumbnail view
Bug 90577 Accessibility for clearing Recent Docs
Bug 79889 Recent docs consistent with recent items list in 
File > Recent Documents
Bug 79198 Close button doesn’t reappear after being 
clicked
and so on...
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LibreOffice Productivity Suite

Import Cell Styles into Calc using Orcus

By Jaskaran Veer Singh
Google Summer of Code 2016
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What are Cell Styles ?

Cell Styles = A set of Attributes

Example :
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What is Orcus ?

Standalone Filter Library
Written in C++
Multi-Threaded
Started out as a Kohei Yoshida's project.
Now has 4-5 active and semi-active contributors
Hosted on GITLAB
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Features of Orcus

Import Filters
 
● Open Document Spreadsheet
● OOXML
● XLS
● Plain Text
● Generic XML
● Gnumeric XML

Parsers

● CSV
● YAML
● XML
● JSON
● CSS
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Working of Styles import

Gets to know
What to read

Libreoffice Side Orcus Side

Low Level
Parser

Produces
Callbacks

The Xml
File

DocShell

Orcus
Interface

Styles
Created

On
Screen
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Reasons for Using Orcus

● UNO is slow with all its bells and whistles. 

● UNO's code for importing styles isn't very reusable.

● Orcus is Time and Memory Efficient because of it's
 modern design and data structures.
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What's in store for you

● Predefined styles means Less Clicks, Less              
  Annoyance.

● Calc would now ship with beautiful predefined set    
  of Styles made by our UI/UX team.

● Best Part : Define your own styles !
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An example :
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Location of styles.xml

/Path/to/installation/share/calc/styles.xml
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Attributes that we import

● Font
● Fill
● Cell Protection
● Number Format
● Alignment
● Borders
● Underline, Strikeout

Attributes that we currently don't import

● Conditional format
● Various properties of Alignment
● Various trivial attributes
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What we want from you

●  Hold on to your seats till this functionality is             
   available.

●  Use this as much as you want when it's available

●  Report bugs to us on bugzilla.

●  Report if you want any attribute to be imported        
   which currently isn't.

●  Contribute to Calc and Orcus ;-)
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Review of Sidebar and it’s functionality

Susobhan Ghosh
Google Summer of Code 2016Mentors: bubli, jphilipz
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Introduction

Junior Year – Computer Science and Engineering Student – 
International Institute of Information Technology, Hyderabad 
(IIIT-H), India

A big thank you bubli and jphilipz for guiding me throughout 
and putting up with me. Also thank you to the design team 
and dev channel members

Thanks to the community for organizing the conference and 
providing this opportunity to present my work

No code, just screenshots! Detailed info at my blog – 
https://susobhang70.github.io
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tdf#83830: Page Deck for Writer

Most used Writer Properties – just one click away!
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tdf#89466: Properties Panel for Impress/Draw 

Panel developed by bubli, 
jphilipz and Rishabh (merged 
this May) – I mainly worked 
on bugs and improvements

Added Master Slide Button, 
Close Master View Button

Enabled same panel for 
Draw
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tdf#87643: Shapes Deck & Default Shapes Panel 
(Draw)

10 categories – 153 shapes 
(Same shapes found on the 
shapes toolbar in Draw)

More Shapes Panel (WIP) 
would go in the Shapes Deck 
below Default Shapes Panel
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tdf#87794: Media Playback Panel in Properties 
Deck

Now Media Playback toolbar is no longer required! 
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Other Improvements

tdf#93845: Show Previews 
checkbox for Writer Styles

tdf#90078: Import Bitmap 
Functionality to Area Panel
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What now?

Most panels arriving in LO 5.3

QA issues are being worked on.

Use the panels, report bugs!

Perhaps contribute to Sidebar development?
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Unifying LibreOffice Low Level Text Layout

Unifying LibreOffice Low Level Text Layout

Akash Jain (autoit)
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Unifying LibreOffice Low Level Text Layout

SalLayout

UniscribeLayout

WinLayoutGraphiteLayout

ServerFontLayout

GenericSalLayout CTLayout

PspFontLayout

GraphiteServerFontLayout PspServerFontLayout

SimpleWinLayout

GraphiteWinLayout

MultiSalLayout

Problem
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Unifying LibreOffice Low Level Text Layout

Problem: complexity

3 classes on Windows, simple, OpenType and Graphite.
4 classes on Unix, OpenType, Graphite, and 2 just for 
PostScript printing.
1 class on macOS, but no Graphite support.
Now imagine how much work is needed to add support for 
something as simple as user controllable font features.
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Unifying LibreOffice Low Level Text Layout

Problem: inconsistency

Different code paths on different platform, or even for different 
writing systems, with little to no code sharing.
Language/writing systems support varies between platform 
APIs.
It varies even between different versions of the same 
platform.
Different platform APIs allow for different levels of integration.
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Unifying LibreOffice Low Level Text Layout

GSoC project: idea

One class to rule them all.
Based mostly on the existing Unix implementation.
Uses HarfBuzz for everything; OpenType, Graphite and even 
AAT on macOS.
Font loading is still done by platform APIs, for better 
integration.
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GSoC project: status

A new class, CommonSalLayout. Naming is really hard!
Code integrated with font and graphics libraries on all 
supported platforms. Can be switched on/off at run time.
Some issues remain:

There seem to be some performance regressions.
Font fallback does not work on macOS.
Some Graphite fonts are broken (e.g. Awami font), 
GenericSalLayout::ApplyDXArray() I’m looking at you!
Non-SFNT (e.g. Type 1) fonts are not currently supported.
Controlling font features is not yet supported.
Windows XP is not supported.

Code should land on master soonish.
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SalLayout

UniscribeLayout

WinLayoutGraphiteLayout

ServerFontLayout

GenericSalLayout CTLayout

PspFontLayout

GraphiteServerFontLayout PspServerFontLayout

SimpleWinLayout

GraphiteWinLayout

MultiSalLayout

feature/commonsallayout 
branch, and soon in master

CommonSalLayout
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SalLayout

GenericSalLayout

MultiSalLayout

Post 5.3 release

CommonSalLayout
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Where do want to go…

All text and image content in this document is licensed under the Creative Commons Attribution-Share Alike 3.0 License 
(unless otherwise specified). "LibreOffice" and "The Document Foundation" are registered trademarks. Their respective logos 
and icons are subject to international copyright laws. The use of these therefore is subject to the  trademark policy.

Thank you … for working on this!

Thanks a lot for your attention
Thank you GOOGLE for sponsoring!!!
Thank you mentors for your time & encouragement
Spread the word, encourage students to apply 
next year!

http://creativecommons.org/licenses/by-sa/3.0/
http://wiki.documentfoundation.org/TradeMark_Policy
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